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Foreword

Textease Studio CT is the single biggest Softease development
since the company’s launch of Textease in 1994. We have listened
to thousands of teachers who use Textease every day to drive this
development.

Textease Studio CT is a fully integrated set of software tools. This
revolutionary principle means that all the tools have the same easy
to use interface and, because they all work in a similar way, having
mastered one the others are easy to pick up. Textease Studio CT
has been carefully thought out to give you NINE KEY TOOLS in a
single application making it ideal for embedding ICT throughout
the curriculum.

Textease Movies CT - produce inspirational and exciting movies
in minutes
Textease Draw CT - a revolutionary vector drawing tool that will

turn your world around
Textease - best in class for creativity and enjoyment

Textease Database - the first multi-user database with
attitude!

Textease Paint CT - a vibrant paint package to inspire creative
young minds

Textease Spreadsheet CT - power and flexibility - you can count
on it!

~
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Textease Branch CT - a powerful and imaginative way to sort
and classify

Textease Presenter CT - create top-notch presentations to be
proud of

Textease Turtle CT - flexible, progressive on-screen turtle
graphics

All of the above tools except Textease Movies CT _:i}j share a
common interface and therefore the same desktop icon .

In addition to the Textease Studio CT tools, you will also be able to
open Textease Timeline and Textease IdeasMap from the toolbar.
These additional products are available to you for 30 days from
installation so you can experiment away and get a real flavour for
their classroom potential. If these additional products are not
purchased, the demonstration versions will expire after 30 days.

Community @ Home Licence

Don’t forget our Community @ Home licence is a great way to
provide pupils and teachers with the same software they have in
school for use at home.

For further information about any of our products visit

www.softease.com, call sales on 01335 343421 or email
sales@softease.com.

www.softease.com [ 3
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Introduction

Textease Movies CT provides an easy and straightforward way to
use video editing software to create imaginative and exciting
movies. Designed specifically for use in education Textease Movies
CT is an excellent way to enable pupil creativity across the
curriculum.

Movies are created by linking video clips and/or a series of still
images together. These images can be captured directly using a
digital camera or taken from a folder already held on the
computer. Transitions, effects, sounds and text are all easily added
to the movie within the same video editing page. A colour coded
timeline for each element of the movie (picture, transitions, text,
effects and sounds) enables pupils to explore different movie
possibilities and make adjustments as their project progresses.

Textease Movies CT can also be used to create stop frame
animations from clipart or drawings (created in Textease Paint CT).
These animations could be used to tell a story or bring a design for
a moving object to life.

www.softease.com @



Getting Going - As video clips (movies) are the
default file type searched for only

files of this type will be displayed. To SEErm
» Go to the ‘Start’ buttononyour [ . b t)I/Ip i kp yth o=
S e . search for still images click on the
desktop and in ‘All Programs’ & | o ) 9 ) i [
. ' = arrow to the right of the box ‘Files of || =i = Lo
select ‘Softease’, ‘Textease . dch the file t . S
i e e:” and change the file type to .
Studio CT’ then ‘Textease Movies |- ‘yp ) g yp Fig.4
cT e Images’.
o ) - Once you have located a video clip or picture to include in your
Alternatively double click on the g T omomomomomomomomom o=

movie select it with a double click. Or, click on it once then click
shortcut on your desktop. Fig.1
: ‘Open’. The video clip or picture will automatically be added to

the ‘Bank’ and the selection window will close.
Textease Movies CT will open with a blank timeline already in

place (Fig.1). . . . o
« Import Videos and Pictures Directly onto the ‘Timeline’

Videos and pictures can be added to the ‘Timeline’ at the same
Addlng Items to Create a Movie time as they are added to the ‘Bank’.
- While selecting a video or picture to add to the ‘Bank’ click in
the box at the bottom of the selection window next to the
words: ‘Add directly to the timeline’ (Fig.4).

@3{ - The selected video or picture will be automatically placed at
W

Add Videos and Pictures

» Import Videos and Pictures into the ‘Bank’
- Click on either the ‘Add Videos & Pictures’ button
(Fig.2), the ‘Videos & Pictures’ tab (Fig.3), or click
on ‘Bank’ on the menu bar then ‘Add Video or

the start of the ‘Timeline’ or immediately adjacent to any videos

and pictures already on the ‘Timeline’.

. ) Fig.2
Picture...’. Capture Vid
» Capture Video
- A window will open which will allow you to search for the video P
- Before opening Textease Movies CT connect a digital video

or picture you want from all folders I —— o
) Yideos & Pictures camera or a webcam to your computer. (Most standard digital
stored on your computer (Fig.4). 1

I 1 cameras can be used as a webcam.)

Each time this window is opened it )
Fig.3 - Having opened Textease Movies CT, click on the ‘Capture

Video’ button on the toolbar , or click on ‘Capture’ on the
menu bar then ‘Video...". The ‘Video Capture’ window will open

will automatically open within the last
folder accessed.

7\
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(Fig.5).

- Click on the ‘Record’ IE' button to begin
recording.

- Click on the ‘Stop’ button IEI to end the
recording.

- Click on the ‘Play’ button to play Fig.5
back the recording.

- If you are not happy with the recording click on the ‘Record’
button and repeat the previous three steps. All previous
recordings will be overwritten.

If you are happy with the recording close the ‘Video Capture’
window by clicking on the cross in the top right hand corner. A
‘Save as’ window will open automatically.

- Name the video clip and select a folder to save it in, then click
‘Save’. (A video clip must be saved before it can be placed in the
‘Bank’ or on the ‘Timeline’.)

- The captured video clip will automatically be placed in the
‘Bank’.

Transfer Videos and Pictures from the ‘Bank’ to the ‘Timeline’

- Select the video or picture to D
transfer to the ‘Timeline’” by

clicking on it. (The selected item & .
will appear to have a blue film =
over it.) Then, keeping the left -

mouse button held down, drag it | . . .

onto the ‘Videos & Pictures’ Fig.6
section of the ‘Timeline’. Release

the mouse when the video or picture is in position (Fig.6).

Textease Movies CT

» Repeat the above processes to add more videos or pictures to the
‘Bank’ or ‘Timeline’.

Add Transitions
Transitions are mostly used to enable a video clip or

still image to run smoothly into another. A transition

!

Fig.7

can also be placed at the start, or end, of a movie

allowing the image to appear or fade out gradually.
(See the example ‘Water’ in the

Resource Bank’.) Transitions
« Click on either the ‘Add Transition’ I 1
button (Fig.7), the ‘Transitions’ tab Fig.8

(Fig.8), or click on ‘Bank’ on the menu
bar then ‘Add Transition... .

» The ‘Transition” window will open
(Fig.9).

* Use the scroll bar, on the right hand

side of the window, to view the full

range of transitions.

Fig.9
« Click on a transition to select it then &
click on the ‘OK’ button. The
selected transition will be added e 1| o]
to the ‘Bank’. e -
« Drag the selected transition onto Fig10

the ‘Transitions’ part of the

‘Timeline’. Place it at the start or end of a video clip or still
image, or between two items on the ‘Videos & Pictures’ timeline
(Fig.10). (N.B. If the transition is placed between two items on

/
[
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the ‘Videos & Pictures’ timeline those items will automatically ‘Effects’ part of the e _
overlap each other.) ‘Timeline’, placing it under | =" =000
» Adjust the duration of the transition by selecting it, then click on the video or picture you -:
the red line and drag the sizing arrow inwards or outwards. want to display the effect m b T
» Repeat the above steps to add different transitions to the ‘Bank’ on (Fig.14). Fig1a
and then the ‘Timeline’. Or, drag the same transition onto the  Adjust the duration of the
‘Timeline’ as many times as required. effect by selecting it, then click on the red line and drag the
sizing arrow inwards or outwards.
Add Effects » Repeat the above steps to add different effects to the ‘Bank’
Effects can be added to videos and pictures to change their and then the ‘Timeline’. Or, drag the same effect onto the
appearance. Effects can be added to the whole S ‘Timeline’ as many times as required.
movie, a single video clip or picture, or to just a small
section of a video clip. More than one effect can be + Add Text
used within a movie, although only one effect can be Text can be integrated into a movie in many
viewed at any one time. (See the example ‘Bonfire Fig.11 different ways. It can appear on its own or with a @
Night’ in the ‘Resource Bank’.) video clip, or still image, behind it. Movies can be
» Click on either the ‘Add Effect’ produced where text is used as a title frame and then, if Fig:13
button (Fig.11), the ‘Effects’ tab required, to label images. (See the
(Fig.12), or click on ‘Bank’ on the example ‘Heads, Shoulders, Knees & e
menu bar then ‘Add Effect...’. Toes’ in the ‘Resource Bank’.) Or, L Fig 16 :
 The ‘Effects’ window will open (Fig.13). movies can be created around a text,
» Use the scroll bar, on the right hand side of the window, to view where images (moving or still) are used to illustrate the words
the full range of effects. within the text. (See the example ‘Bonfire Night’ in the ‘Resource

Bank’.)

» Click on either the ‘Add Text’ button (Fig.15), the ‘Text’ tab
button (Fig.16), or click on ‘Bank’ on the menu bar then ‘Add
Text... .

« Click on an effect to select it then
click on the ‘OK’ button. The
selected effect will be added to the
‘Bank’.

» Drag the selected effect onto the

@ Textease Movies CT www.softease.com @




» The ‘Text’ window will open (Fig.17).
» Type in the text to be displayed, using
the ‘Return’ key on your keyboard to

place text on a new line. Text will be
| e |

sty | bors

centred automatically when viewed as

a movie. (N.B. As Textease Movies CT

[l chireeiy et L= |

does not make adjustments to the Fig17

layout of the text entered if the text is

typed on just one line it will be displayed on only one line.
Equally, text that doesn’t ‘fit’ onto the screen will not be visible
when playing the movie.)

» Text will automatically be displayed on a transparent
background, enabling it to be placed over videos and pictures. If
you want to view text on its own, without an image behind it,
click on the tick next to the words ‘Transparent Back’ to deselect
it (Fig.21).

» To add the text to the bank now, without adding text effects,
click on ‘OK’. Or, see the Add Text Effects section (on page 19)
for further guidance.

Add Sounds

Sound can be used within a movie in a number of ways. It can be
played as a background to a silent video clip (or selection of
images), used to open or close a movie and/or linked directly to
text. A huge variety of sounds can be added to a movie. For
example, the pre-recorded sound of a barking dog taken from the
‘Resource Bank’, or a direct recording of a group of children
reading or singing along with the text. (See the example ‘Heads,
Shoulders, Knees & Toes’ in the ‘Resource Bank’.)

\
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» Add a Pre-recorded Sound
- Click on either the ‘Add Sound’ button (Fig.18),
the ‘Sounds’ tab (Fig.19), or click on ‘Bank’ on the @
menu bar then ‘Add Sound...’.

- A window will open which will allow you to search

Fig.18
for the sound you want from all folders stored on

your computer (Fig.20). Each time _

- . - Sounds
this window is opened it will : 1
automatically open within the last Fig19

folder accessed.
- Once you have located a sound to include in your movie select
it with a double click. Or, click on it once then click ‘Open’. The

sound will automatically be added to
the ‘Bank’ and the selection window
will close. (Click in the box at the

bottom of the selection window next : :
to the words: ‘Add directly to the P T o Lemr]
timeline’ to place the sound on the :

‘Timeline’ as well as in the ‘Bank’.)
- Repeat the above process to add more sounds to the ‘Bank’.

» Capture a Sound

- Connect a microphone to your computer.

- Click on the ‘Capture Audio’ button on the toolbar
, or click on ‘Capture’ on the menu bar then =
‘Audio...’. The ‘Audio Capture’ window will open Fig21
(Fig.21).

- Click on the red ‘Record’ button to begin recording.

- Click on the ‘Stop’ button to end the recording.

/
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- Click on the ‘Play’ button to playback the recording.

- If you are not happy with the recording click on the ‘Record’
button and repeat the previous three steps. All previous
recordings will be overwritten.

If you are happy with the recording close the ‘Audio Capture’
window by clicking on the cross in the top right hand corner.

- A ‘Save as’ window will open automatically. Name the audio
clip and select a folder to save it in, then click ‘Save’. (A sound
must be saved before it can be placed in the ‘Bank’ or on the
‘Timeline’.)

- The recorded sound will be placed in the ‘Bank’.

o Listen to an Individual Sound Stored in the ‘Bank’
- Select the sound you wish to listen to by clicking on it. Then
click on the ‘Play’ button (under the ‘Movie’ screen). The audio
clip will now play.

» Transfer a Sound from the ‘Bank’ to the ‘Timeline’

- Select the sound to transfer =

it 4 Bichrns

onto the ‘Timeline’ by clicking

on it, then, keeping the left
mouse button held down, m
drag it onto the ‘Sounds’ = _

section of the ‘Timeline’.
Release the mouse when the
sound is in position (Fig.22).

@ Textease Movies CT

Reposition or Remove Items Placed
on the Timeline

Items placed on the ‘Timeline’ can be repositioned or removed at
any time.

« To reposition videos and pictures, sounds, effects and text
placed on the ‘Timeline’:
- Select the item to be moved by clicking on it. (The selected
item will appear to have a blue film over it.)
- Then, keeping the left mouse button held down, drag it along
the timeline into a new position.

= To remove videos and pictures, sounds, transitions, effects and
text placed on the ‘Timeline’:
- Select the item to be removed by clicking on it. (The selected
item will appear to have a blue film over it.)
- Then, click on the ‘Delete’ button on the toolbar , OF press
‘Delete’ on your keyboard.

Viewing a Movie

View an Individual Video Clip

Individual video clips stored in the ‘Bank’ can be viewed at any

time.

» Select the video clip you wish to view by clicking on it. (The
selected item will appear to have a blue film over it.)

www.softease.com @



¢ Click on the ‘Play’ button (under the i Edltlng a Movie
‘Movie’ screen). The video clip will o g '

now play (Fig.23).
« Click on the ‘Stop’ button to stop the

clip playing. S s

Edit a Video Clip

Once a video clip has been placed on the ‘Timeline’ it can be

edited. The clip can be cropped so that only a section of it is

Fig.23 played, the duration the clip plays for can be reduced and the

speed the clip plays at can also be adjusted.

View the Whole Project on the Movie Screen - Select the video clip, on the

Textease Movies CT allows you to use the ‘Movie’ screen to watch P . .
Timeline’, you wish to edit by
your movie at any time during the creation process (Fig.23).

clicking on it. Two red lines will

e Click anywhere on the ‘Timeline’ then on the ‘Play’ button appear either side of the selected Fig.24

(under the "Movie” screen) to begin playing your movie. clip (Fig.24). The outside lines adjust the clip’s duration and

« Click on the ‘Pause’ button to view a “freeze frame” image of a T N
speed, the inside lines are cropping lines.
section of your movie.

« Click on the ‘Stop’ button to stop the movie playing. - Crop a Video Clip

. o Decide how you wish to crop the video clip. Do you want to
View the Movie in Full Screen

» Click on the ‘Full Screen’ button under the ‘Movie’ screen,
or click on ‘Movie’ on the menu bar then ‘Fullscreen’.

remove footage from the start of the video clip, the last section,
both the start and end, or the middle of a video clip? (See the

example ‘Water’ in the ‘Resource Bank’.)

 Click on the left mouse button to play your movie. - With the video clip selected, move the mouse pointer over the

« Click on the right mouse button to return to the movie editing inside red line (Fig.24) on the side of the video clip you want to

screen. crop from. The mouse pointer will change to the cropping
symbol.
- Click and drag the cropping symbol inwards (keeping the left
mouse button held down). Watch the movie viewing screen as
you crop to see what section of the video clip the cropping tool
has reached.
- Release the mouse to stop cropping.
(10) . ~
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- Click on the ‘Play’ button to view the clip. Repeat the above
steps, until only the desired section of the video clip is shown.

NB. If you want to remove a section from the middle of a video
clip you will need to put two copies of the clip on the timeline.
On the first copy of the clip crop from the end sequence up to
the start of the section you want to remove. On the second copy
crop from the starting sequence up to the end of the section you

want to remove.

» Adjust the Speed a Video Clip Plays At

Once a video clip is cropped the length of time it plays for will
need to be adjusted. Otherwise the video clip will play in slow
motion, since there is less video footage for the same amount of

time.

Equally, you may want to view a video clip in slow motion (or
speeded up). For example, footage taken of a fairground ride could
be viewed in slow motion, providing pupils with a better
understanding of how it works.
- Move the mouse pointer over one of the red lines on the
outside edge (Fig.24 on page 17) of the selected video clip so
that it changes to a sizing arrow.
- Click on the sizing arrow and, keeping the left mouse button
held down, drag the line inwards (to make the clip play faster) or
outwards (to make the clip play slower).
- Release the mouse to finish.
- Click on the ‘Play’ button to view the clip. Continue editing

I[:1 8 Textease Movies CT

until the clip plays at the desired speed.

Edit a Still Image

Once an image has been placed on the ‘Timeline’ the duration it is
shown for within a movie can be reduced or increased. (See the
example ‘Heads, Shoulders, Knees & Toes’ in the ‘Resource Bank’.)

« Select the image, on the ‘Timeline’, you wish
to edit by clicking on it (Fig.25).
» Move the mouse pointer over one of the red

lines on the outside edge of the selected

image so that it changes to a sizing arrow. Fig25

« Click on the sizing arrow and, keeping the left
mouse button held down, drag the line inwards (to show the
image for a shorter time period) or outwards (to show the image
over a longer time period).

« Release the mouse to finish.

» Click on the ‘Play’ button to view your project so far. Continue
editing until the image is shown for the desired length of time.

Add Text Effects

Any changes made to the text will be applied to all the text
contained within the selection. To apply effects to individual words
or groups of words you will need to create them individually, i.e.
repeat the steps to ‘Add Text’ on page 11 for each word or group
of words.

Text effects can be added when the text is initially written or by
selecting text in the ‘Bank’, or on the ‘Timeline’, with a double

www.softease.com (19 )



click. Changes made to text already placed on the ‘Timeline’ will
not affect the original text held in the ‘Bank’.

» Change the Text Font Style, Size and Colour

- Click on the ‘Font’ button within the ———0n
‘Text” window (Fig.26) to open the T

‘Font’ options window (Fig.27).

- Select a new font type, style, size and
colour. BT T e

sty | bors -

- Click ‘OK’ once all your selections Py ==

have been made. Fig.26

« Animate Text

Text can be animated so that it is
scrolled horizontally or vertically onto
the screen. Text animation is
particularly effective within stories or

i

poems. (See the examples ‘Bonfire ——
Night” and ‘Number Story’ in the

‘Resource Bank’.) Fig.27
- Within the ‘Text’ window (Fig.26)

click on the drop down menu arrow
to the right of the word ‘None’ and oo
select an animation style (Fig.28).

» Change the Text Background
Colour

Text will automatically be displayed

on a transparent background, Fig.28

@ Textease Movies CT

enabling it to be placed over videos and pictures. If you want to
view text on its own, without an image behind it, click on the tick
next to the words ‘Transparent Back’ in the ‘Text’ window (Fig.26)
to deselect it.

- Click on the ‘Background Colour’
button in the ‘Text’ window
(Fig.26) to open the ‘Colour’ menu
(Fig.29).

- Select a background colour then
click “‘OK’.

» When you have finished adding text effects click in the box at
the bottom of the ‘Text’ window to add the text directly to the
‘Timeline’, then click ‘OK’.

Edit an Audio Clip

Once an audio clip has been placed on the ‘Timeline’ it can be
edited in exactly the same way as a video clip can. The clip can be
cropped so that only a section of it is played, the duration the clip
plays for can be reduced and the speed the clip plays at can also
be adjusted. (Refer to “Edit a Video Clip” on page 17 for details.)

Using the Revert Button

The ‘Revert’ function allows you to return an item on the
‘Timeline’ to its original state no matter how many changes you
have made to it, or how many other items you have added or
edited.

« Select the item to be reverted to its original state.

« Click on the ‘Revert’ button on the toolbar.

www.softease.com @



Adjust the Timeline Display Create a Stop Frame Animation
Using Paintings Created in
Textease Paint CT

The timeline at the bottom of the screen displays the duration
items placed on the ‘Timeline’ will play for (Fig.30).

Stop frame animations using paintings created in Textease Paint

CT are fun and easy to create. See the examples ‘Moving Toy

Fig.30 Animation’ and ‘Number Story’ in the ‘Resource Bank’.

« Create a painting in Textease Paint CT.

» Click on the ‘Animate’ button , on the ‘Paint’ toolbar.

» The program will automatically ask you to save the painting.

Being able to ‘Zoom in’ to the timeline enables you to edit video
and audio clips more precisely. The ‘Zoom in’ tool reduces the

total amount of time displayed on the screen from whole second

blocks to fractions of a second. (N.B. Items already placed on the Give the painting a title with a numerical value at the end (for

example ‘owl1’), to make it easier to identify individual pictures
‘Timeline’ above will appear to stretch, however the duration these P ) y P

. . . within a series, then click ‘Save’. (NB. The Textease page will not
items will play for remains the same.)

have been saved. You will need to do this at the end of the

rocess if you wish to keep the Textease file.
The ‘Zoom out’ tool increases the amount of time displayed in the P y P

) ) ) . « If Textease Movies CT is not already open it will automatically
screen, enabling you to view longer projects more clearly (i.e.

projects which last for over a minute). Once you have zoomed out, open. The image will have been added to the bank.

more items will be contained within the section of the ‘Timeline’  To add further images to the bank go back to Textease Paint CT
displayed.

« Click on the ‘Zoom In’ or ‘Zoom Out’ buttons (Fig.31) Q

and modify the painting on the Textease page. For example, on
a painting of an owl change the position of its wings (see the

example ‘Moving Toy Animation’ in the ‘Resource Bank’).
next to the timeline at the bottom of the screen. (Keep P 9 oy )

» Repeat the last four steps as many times as required.

clicking until the scale makes it easier for you to work on Q

your project.) ¢ Create a title frame for your animation and place this at the

Fig.31 start of the ‘Timeline’.

« Place the drawings in sequential order on the ‘Timeline’, using
the same image several times if appropriate. For example, three
images where the owl’s wings get higher each time, then the
same images in reverse order showing its wings lowering again.

« Play your animation.

@ Textease Movies CT www.softease.com @



Curriculum Examples

A number of curriculum examples using Textease Movies CT can

be found in Textease Resources. To access Textease Resources in
Textease Movies CT you will need to click on the ‘Add Videos &
Pictures’ button or the ‘Add Sounds’ button then browse to where

you installed them, for example c:\Program files\Softease\etc...

Textease Movies will remember the location it last browsed to.

Use Textease Movies CT in...

Design and Technology
to animate the design of a
moving object and combine
it with a video clip showing
the finished model in action.

Literacy

to integrate text in a poem
or story with visual and
audio effects.

@ Textease Movies CT
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to add images and text to
songs and pieces of music.

Music A

-8 |
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Geography

to illustrate different
geographical features
through sound and images.

...use across the curriculum.

www.softease.com @



Further Help

This guide and all other ‘Getting Started Guides’ are available
from the ‘Help’ menu.

Over 70 cross-curricular examples for all year groups in KS1&2 are
included in the Textease Studio CT ‘Resource Bank’. A series of
short ‘Getting Started’ video demonstrations can also be found
on our website (from within the product select ‘Help’ on the menu
bar, then ‘On the website’ and ‘Getting Started videos’). For
further examples and ideas on how to use these software tools
effectively in the classroom, including a regularly updated ‘Top
Tips’ section, visit our website at www.softease.com.

For further information about how Textease can be used to
support and extend pupils of all abilities visit
www.softease.com/downloads where you can download ‘Using
Textease to Promote Inclusion and Accessibility’.

Sharing Ideas

We would love to see examples of how your school has used our
software tools to create resources of your own. If you have any
examples you would like to share with us, and other schools, please
email them to customercare@softease.com and we will add them
to our website.

Technical Support
Softease products are designed to be easy to use, but from time to
time everyone needs some help. You can access online support at

[:26 Textease Movies CT

www.softease.com/support where you will find a list of frequently
asked questions, the answers to which we hope will solve your
problem. If you still need help call our Technical Support team
between 9am — 5pm, Monday to Friday. Outside of office hours
you can email support@softease.com and our support team will
reply as soon as possible.

To contact the Technical Support team:

Tel: 01335 301200
Email: support@softease.com
Visit: www.softease.com/support

Stay Up to Date

Don’t forget to sign up for our regular email updates which give
details of the latest product releases, twilight seminars in your
area, new Top Tips, and lots more. Visit
www.softease.com/register to submit your contact details.

Online Updates

Your software includes a new feature to make installation of future
updates quicker and easier than ever before. The software now
comes with an online update button that automatically
appears on the toolbar when there is a new version available. This
button can only be accessed by administrators, otherwise it will
appear greyed out. The online update is downloaded via the
internet, and will automatically update any previous version 6
releases installed. See the ‘Installation Instructions’ for further
details.

/ i -\\\I
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Certain images provided are copyright Nova Development and its
licensors. Images ©1997, 1998, 2004 Nova Development and its
licensors; ©1996 Cliptoart; ©1995 Expressions Computer
Software; ©1997-98 Seattle Support Group; ©1999 Software

Syndicate Inc.; © Management Graphics, Ltd.; © 1996-99 Hemera

Technologies, Inc. All rights reserved.

Oxford Reading Tree Clip Art Story Characters, © Sherston
Software Limited and Oxford University Press 1997.

Development Team

Development Manager: Steve Taylor

Product Development: Richard Cunningham, Rob Davies, Jane
Doran, Mark Harrison, Mark Ingram, Craig Robson, Ian White,
Matthew Wilcoxson

Graphic Design: Paul Gowdridge
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Educational Consultants: Doug Dickinson, Fiona Panni
Project Manager: Heather Purdom

Minimum System Requirements

Windows 98SE (Windows XP recommended), P3 750 MHz, 64 MB
(128 MB recommended), Direct-X compatible 32 bit colour, 50 MB

HDD space, resolution of 800 x 600.

Textease Resources
700 MB HDD space.

Additional Requirements
Windows NT requires Service Pack 6.
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Textease Studio

The Ultimate in

Includes:

Textease Movies
Textease Draw
Textease

Textease Database
Textease Paint
Textease Spreadsheet
Textease Branch
Textease Presenter
Textease Turtle

www.softease.com/studioct

§Soflease

Softease, Market Place,

Ashbourne, Derbyshire,

DE6 1ES

F: 01335 343422

www.softease.com

Sales: sales@softease.com
T: +44 (0)1335 343421

Customer Care: customercare@softease.com
T: +44 (0)1335 301201

Technical Support: support@softease.com
T: +44 (0)1335 301200
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